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INTRODUCTION 

The objective of IT Workshop is to impart basic computer usage and maintenance skills and to 

introduce you to a suite of productivity tools that will aid in your day to day activities.  

IT workshop works in a learning-by-doing mode. It concentrates more on hands-on experience for 

the participants rather theoretical classes. It enables the participant to make the best use of 

Microsoft Office Suite in their day-to-day requirements and make use of it to improve the standards 

in the educational environment. The IT Workshop prepares the participant to have a hands-on 

experience in maintaining and troubleshooting a PC by themselves. 

Computer Hardware, Windows & Linux 

Hardware comprises all of the physical parts of a computer, as distinguished from the data it 

contains or operates on. Software provides instructions for the hardware to accomplish tasks. 

Windows is a range of closed source proprietary commercial operating environments for personal 

computers and also servers. This range was first introduced by Microsoft in 1985 and eventually has 

come to dominate the world of personal computer market. All recent versions of Windows are full-

fledged operating systems.  

Linux is a computer operating system. It is among the most famous examples of free software and of 

open-source development. Initially, Linux was largely developed and used by individual enthusiasts.  

Productivity Tools 

 Microsoft Office is a suite of productivity programs created by Microsoft and developed for 

Microsoft Windows and Apple Macintosh operating systems. In addition to the office applications, it 

includes associated servers and Web-based services. 

Office is considered to be the de facto standard for productivity programs, and has many features 

not present in other suites. However, the reverse is also true, with other programs having 

capabilities that Office doesn't. 

Microsoft Office suite includes Word, Power Point, Excel, Publisher, and Outlook in most of its 

versions.  
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Internet and World Wide Web 

 Internet & World Wide Web module introduces the different ways of hooking on to the internet 

from home and workplace and effectively usage of the internet. Usage of web browsers, email, 

newsgroups and discussion forums would be covered.  

 

Outcomes: 

PC Hardware introduces the students to a personal computer and its basic peripherals, the process 

of assembling a personal computer, installation of system software like MS Windows, Linux and the 

required device drivers. In addition hardware and software level troubleshooting process, tips and 

tricks would be covered. The students should work on working PC to disassemble and assemble to 

working condition and install Windows and Linux on the same PC. Students are suggested to work 

similar tasks in the Laptop scenario wherever possible. Internet & World Wide Web module 

introduces the different ways of hooking the PC on to the internet from home and workplace and 

effectively usage of the internet. Usage of web browsers, email, newsgroups and discussion forums 

would be covered. In addition, awareness of cyber hygiene, i.e., protecting the personal computer 

from getting infected with the viruses, worms and other cyber attacks would be introduced. 

Productivity tools module would enable the students in crafting professional word documents, excel 

spread sheets and power point presentations using the Microsoft suite of office tools and Latex. 

(Recommended to use Microsoft office 2007 in place of MS Office 2003) 
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TASK 1 

Identifying the peripherals of a computer 

 

Identify the peripherals of a computer, components in a CPU and its functions. Draw the block 

diagram of the CPU along with the configuration of each peripheral and submit to your instructor. 

AIM: To identify the peripherals of a computer. 

Introduction to Computer Hardware: 

Hardware is the physical appearance of the devices or tools. It is what which we can touch and feel. 

Computer Hardware consists of the Monitor, CPU, Keyboard, Mouse and all other devices connected 

to the computer either externally or internally. 

The Mother Board 

There are primarily two types of motherboards, AT motherboard, and ATX motherboard. AT 

motherboards. The AT and ATX motherboards differ in the form factor. Full AT is 12" wide x 13.8" 

deep, and Baby AT is 8.57" wide x 13.04" deep.  Full-ATX is 12" wide x 9.6" deep and Mini-ATX is 

11.2" wide x 8.2" deep. Other major differences include power supply connector, and keyboard 

connector. AT has 5-pin large keyboard connector, whereas ATX has 6-pin mini connector. Similarly, 

AT has single row two connectors +/-5V, and +/-12V, whereas ATX motherboard has double row 

single connector providing +/-5V, +/-12V, and +3.3V. 

The important constituent components of an ATX Motherboard are given below:  
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1. Use & keyboard 

2. Usb 

3. Parallel port 

4. Cpu chip 

5. Ram slots 

6. Floppy controller 

7. Ide controller 

8. Pci slot 

9. Isa slot 

10. Cmos battery 

11. Agp slot 

12. Cpu slot 

13. Power supply plug in  

1. Mouse & keyboard:     

 

Keyboard Connectors are two types basically. All PCs have a Key board port connected directly to 

the motherboard. The AT-style keyboard connector is quickly disappearing, being replaced by the 

smaller mini DIN PS/2-style keyboard connector. 
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2. USB (Universal serial bus):  

 USB is the General-purpose connection for PC. You can find USB versions of many different 

devices, such as mice, keyboards, scanners, cameras, and even printers. a USB connector's 

distinctive rectangular shape makes it easily recognizable. USB has a number of features that 

makes it particularly popular on PCs. First, USB devices are hot swappable. You can insert or 

remove them without restarting your system.  

3. Parallel port: 

Most printers use a special connector called a parallel port. Parallel port carry data on more than 

one wire, as opposed to the serial port, which uses only one wire. Parallel ports use a 25-pin female 

DB connector. Parallel ports are directly supported by the motherboard through a direct 

connection or through a dangle.  

4. CPU Chip : 

The central processing unit, also called the microprocessor performs all the calculations that take 

place inside a pc. CPUs come in Variety of shapes and sizes.Modern CPUs generate a lot of heat and 

thus require a cooling fan or heat sink. The cooling device (such as a cooling fan) is removable, 

although some CPU manufactures sell the CPU with a fan permanently attached.  

5. RAM slots: 

Random-Access Memory (RAM) stores programs and data currently being used by the CPU. RAM is 

measured in units called bytes. RAM has been packaged in many different ways. The most current 

package is called a 168-pin DIMM (Dual Inline Memory module).     

6. Floppy controller: 

The floppy drive connects to the computer via a 34-pin ribbon cable, which in turn connects to the 

motherboard. A floppy controller is one that is used to control the floppy drive. 

7. IDE controller: 

 Industry standards define two common types of hard drives: EIDE and SCSI.  Majority of the PCs 

use EIDE drives. SCSI drives show up in high end PCs such as network servers or graphical 
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workstations. The EIDE drive connects to the hard drive via a 2-inch-wide, 40-pin ribbon 

cable,which in turn connects to the motherboard. IDE controller is responsible for controlling the 

hard drive.  

8. PCI slot:   

Intel introduced the Peripheral component interconnect bus protocol.  The PCI bus is used to 

connect I/O devices (such as NIC or RAID controllers) to the main logic of the computer. PCI bus has 

replaced the ISA bus.  

9. ISA slot (Industry Standard Architecture): 

 It is the standard architecture of the Expansion bus. Motherboard may contain some slots to 

connect ISA compatible cards.  

10. CMOS Battery:  

To provide CMOS with the power when the computer is turned off all motherboards comes 

with a battery. These batteries mount on the motherboard in one of three ways: the obsolete 

external battery, the most common onboard battery, and built-in battery.   

 

11. AGP slot: 

 If you have a modern motherboard, you will almost certainly notice a single connector that 

looks like a PCI slot, but is slightly shorter and usually brown. You also probably have a video card 

inserted into this slot.This is an Advanced Graphics Port (AGP) slot  

 

12. CPU slot: 

To install the CPU, just slide it straight down into the slot. Special notches in the slot make it 

impossible to install them incorrectly. So remember if it does not go easily, it is probably not correct. 

Be sure to plug in the CPU fan's power.   

 

13. Power supply plug in:   
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The Power supply, as its name implies, provides the necessary electrical power to make the pc 

operate. the power supply takes standard 110-V AC power and converts into  +/-12-Volt, +/-5-Volt, 

and 3.3-Volt DC power.  

2.CPU (Processor) 

The central processing unit (CPU, occasionally central processor unit) is the hardware within a 

computer system which carries out the instructions of a computer program by performing the basic 

arithmetical, logical, and input/output operations of the system. 

 

3. SMPS (Switched mode Power Supply) 

A switched-mode power supply (switching-mode power supply, SMPS, or switcher) is an electronic 

power supply that incorporates a switching regulator to convert electrical power efficiently. 

 

4. Cabinet 

A computer cabinet is an enclosure with fitted, fixed or removable side panels and doors. The 

cabinet contains a computer rack for mounting computers or other electronic equipment. 
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5. CPU heat Sink and fan 

A computer fan is any fan inside, or attached to, a computer case used for active cooling, and may 

refer to fans that draw cooler air into the case from the outside, expel warm air from inside, or move 

air across a heat sink to cool a particular component. 

 

6. RAM (Random Access Memory) 

RAM (random access memory) is the place in a computer where the operating system, application 

programs, and data in current use are kept so that they can be quickly reached by the computer's 

processor. RAM is much faster to read from and write to than the other kinds of storage in a 

computer, the hard disk, floppy disk, and CD-ROM. However, the data in RAM stays there only as 

long as your computer is running. When you turn the computer off, RAM loses its data. When you 

turn your computer on again, your operating system and other files are once again loaded into RAM, 

usually from your hard disk 
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7. HDD (Hard Disk Drive) 

The hard disk is housed inside the hard drive, which reads and writes data to the disk. The hard drive 

also transmits data back and forth between the CPU and the disk. 

 

8. FDD (Floppy Disk Drive) 

 

9. CD-ROM Drive 
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10. CD Writer 

A CDROM (compact disk read-only memory), also written as CD-ROM, is a type of optical storage 

media that allows data to be written to it only once 

 

11. Different Screws Used 

 

12. AGP  (Accelerated Graphics Port) Card 

Stands for "Accelerated Graphics Port." AGP is a type of expansion slot designed specifically for 

graphics cards. 

 

13. LAN (Local Area Network) card 
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A network interface card (NIC) is a computer circuit board or card that is installed in a computer so 

that it can be connected to a network. Personal computers and workstations on a local area network 

(LAN) typically contain a network interface card specifically designed for the LAN transmission 

technology, such as Ethernet or token ring. 
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TASK 2 

Task2: Every student should individually install MS windows XP on the personal computer.  
 

AIM: To install Windows XP 

PROCEDURE: 

1. Keep on press the delete button and go to advanced BIOS feature.                             

[ BIOS- Basic Input Output System ] 

2. And go to boot sequence. Select first boot drivers. CD ROM and press F10 to save 

the bios feature. Yes and then enter. Press any key to boot from CD. Press enter 

to setup windows XP. 

F8 = To agree the license. 

3. Press ESC to don’t repair the windows XP setup. 

4. Press ‘p’ to delete the previous partitions. Then press enter. 

5. Press ‘L’ to delete the partition. 

6. Press ‘C’ to create the partition in the un partition space. 

7. Press enter to setup windows XP on the selected items. 

BASIC FILE SYSTEMS: 

  FAT: File Allocation Table. 

  NTFS: New Technology File System. 

Format the create using NTFS partition 

BASIC STEPS IN INSTALLATION:- 

 Collecting information. 

 Dynamic update. 

 Preparing installation 

 Installing windows. 

 Tracking installation. 

Select the language as English (united states), then ok. 

Enter your name and organization. 

Enter the product key. 
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Enter the computer name and give password (if necessary) then ok. 

Then select the date and time. 

Then select the typical setting. 

Windows XP Installation 

Installation process 

  Installing Windows XP can take up to two hours. To make the process more manageable, it has been 

broken up into several sections. When you are ready, install Windows XP: 

Part 1: Begin the installation 

Part 2: Continue the installation 

Part 3: Complete the installation 

 

Part 1: Begin the installation 

  Insert the Windows XP CD into your computer and restart your computer. 

 If prompted to start from the CD, press SPACEBAR. If you miss the prompt (it only appears 

 for a   few seconds), restart your computer to try again. 
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Windows XP Setup begins. During this portion of setup, your mouse will not work, so you must use 

the keyboard. On the Welcome to Setup page, press ENTER. 

Windows XP Setup begins. During this portion of setup, your mouse will not work, so you must use the  

Keyboard. On the Welcome to Setup page, press ENTER. 

 

 On the Windows XP Licensing Agreement page, read the licensing agreement. Press the PAGE 

DOWN key to scroll to the bottom of the agreement. Then press F8. 
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This page enables you to select the hard disk drive on which Windows XP will be installed. Once you 

complete this step, all data on your hard disk drive will be removed and cannot be recovered. It is 

extremely important that you have a recent backup copy of your files before continuing. When you 

have a backup copy, press D, and then press L when prompted. This deletes your existing data. 

 

 Windows XP erases your hard disk drive using a process called formatting and then copies the setup 

files. You can leave your computer and return in 20 to 30 minutes. 

 

Part 2: Continue the installation 
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 Windows XP restarts and then continues with the installation process. From this point forward, you 

can use your mouse. Eventually, the Regional and Language Options page appears. Click Next to 

accept the default settings. If you are multilingual or prefer a language other than English, you can 

change language settings after setup is complete. 

 

 On the Personalize Your Software page, type your name and your organization name. Some 

programs use this information to automatically fill in your name when required. Then, click Next. 

 

   On the Your Product Key page, type your product key as it appears on your Windows XP CD case. 

The product key is unique for every Windows XP installation. Then, click next. 

http://www.microsoft.com/windowsxp/using/setup/winxp/yourlanguage.mspx
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Part 3: Complete the installation 

Windows XP will spend 20 or 30 minutes configuring your computer and will automatically restart 

when finished. When the Display Settings dialog appears, click OK. 

On the Thank you! Page, click Finish. 
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TASK 3 

Troubleshooting 

Hardware Troubleshooting: Students have to be given a PC which does not boot due to improper 

assembly or defective peripherals 

AIM: Hardware troubleshooting 

Troubleshoot:- 

1. If you hit the power button & nothing happened. 

 Check all power connections. 

 Check for power on mother board.   

2. If the system turns on but does not beep or begin to boot up. 

 Remove all components except motherboard/ cpu / mother check by 

giving power to them  

     Computer error beeps codes: 

No beep: short, no power, bad CPU/ MD, loose peripherals. 

One beep: everything is normal & computer posted tax. 

Two beeps: post / CMOS error. 

One long beep One short beep: Motherboard problem. 

One long beep two short beep: video problem. 

One long beep 3 short beeps: video problem. 

3 long beeps: keyboard error. 

Repeated long beep:  memory error. 

Continuous high- low beeps: CPU overheating Experiment no: 1 
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b) Software Troubleshooting: Students have to be given a malfunctioning CPU due to system 

software problems. They should identify the problem and fix it to get the computer back to 

working condition.  

AIM: Software troubleshooting 

PROCEDURE: 

Error messages encountered during boot before Windows loads 

Ensure that your computer BIOS settings are correctly configured to the hardware that is installed in 

your computer 

Error messages while windows loading 

1. If you have recently installed or changed something that could have caused normal windows to 

stop loading, try loading the last known good configuration 

2. If you are unable to get into Normal windows and believe that removing or uninstalling a program 

or changing a setting may help enable you to get into windows, boot the computer into windows XP 

safe mode 

3.If your computer has worked fine in the past but recently   has been experiencing the issue you are 

encountering run the system restore option to restore the computer to an earlier date Other error 

messages that occur while windows is loading or after windows is loaded 

1. If error occur but windows still loads , verify no issues or conflict exits in device manager  

2. Ensure that if programs are loading automatically that these errors are not associated with these 

programs 

3. Make sure Windows XP is up to date by checking Microsoft windows update page 

4. If your computer has virus protection installed make sure that it is up to date and that no virus are 

being detected 

5. If your computer has worked fine in the past but recently   has been experiencing the issue you 

are encountering run the system restore option to restore the computer to an earlier date. 
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The test consists of various systems with hardware/software troubleshooting related troubles, 

Formatted disks without operating systems 

Take two motherboards, identify the components and explain the functionality of each component 

Given the various components of a computer identify and assemble them 

Given a computer, disassemble it. 

1. Install any OS of choice 

2. Demonstrate basic Linux commands 

3. Install application software of choice 

4. Hardware troubleshooting 

5. Software troubleshooting 
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TASK 4 

Web Browsers, Surfing the Web: Students customize their web browsers with the LAN proxy 

settings, bookmarks, search toolbars and pop up blockers. 

PURPOSE: To learn to surf the web 

THEORY: 

 Web browser provides the means to the searching and also helps to download the web 

content. 

 Web browsers support most of the famous Internet Protocols like HTTP,FTP.  

 Common file formats a browser accepts  are HTML  

 Well known browsers natively support a variety of other formats in addition to HTML such as 

JPEG,PNG,GIF image formats 

 Different web browsers available in the market are: 

 Silver Smith 

 Mosaic 

 Netscape 

 Mozilla 

 Opera 

 Lynx 

 Safari 

Bookmark: 

Each web browser is built-in with the support of Internet Bookmarks which serve as  a named 

anchor – primarily to URLs. The primary purpose of this book mark is to easily catalog and access 

web pages that the web browser user has visited or plans to visit, without having to navigate the 

web to get there. 

Pop-up Blockers: 

Pop-ups are a form of online advertising on the WWW intended to attract the attention of the users. 

These pop ups are hosted on the web sites which are frequently visited by the netizens. These pop 

ups are activated when these web sites open a new web browser window and there by displaying 

the advertisements. 
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Plug-ins: 

A plug-in is a software component program that interacts with a main application to provide a better 

integration of the media. The basic difference between application programs and plug-ins is that 

multimedia files are launched in a separate window where as in plug-ins multimedia play in the 

browser window. 

Few famous plug-ins are: 

 Apple Quick Time 

 Macromedia flash 

 Microsoft Media Player 

 Adobe Shockwave 

 Sun Micro systems Java Applet 

PROCEDURE: 

LAN Proxy Settings: 

 select  tools menu in  Internet Explorer 

 Select Internet Options 

 Select  Connections 

 You end up in two options 

 Dial-up  and virtual network settings 

 LAN setting 

 The selection at this step is dependent on the kind of connection you are trying to  

configure. They are: 

 Dial-up modem connection 

 LAN connection 

 DSL or Cable modem 
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b) How to access the websites and email& Search Engines & various threats on the internet and 

would be asked to configure their computer to be safe on the internet, Antivirus downloads to 

avoid viruses and/or worms. 

PURPOSE: To know what search engines are and how to use the search engines. 

A search engine can be defined as a web site with tools which help you to find information on the 

internet Function of a search engine  You can find anything from a schedule of White house tours to 

instructions for removing stains from clothes. 

Limitations: 

 Search engines visit web sites only several weeks. Search engines cannot see information in other 

data bases later on. 

On the internet a search engine is a coordinated set of programs that includes: A spider (crawler or 

bot) that goes to every page or representative pages on every web site that wants to be searchable 

and reads it , using hypertext links on each page to discover and read site’s other pages.  

Pros: 

 You can select the search terms 

 You can use the same search terms with multiple search engines 

 You can change search terms as much as you wish 

 You will normally receive numerous links 

 Its fast 

Cons: 

 There are so many different search engines it may be difficult to choose 

 You will normally receive too many links often making it difficult to identify the most 

relevant sites. 

 The vast majority of links may be only marginally relevant or altogether irrelevant 

EX: 

 Alta Vista 

 Ask Jeeves 

 Google 
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 Lycos 

Etc.. 

Meta Search Engines: 

 Meta search engines or “met crawlers” don’t crawl the web themselves. Instead they search the 

resources of multiple search engines by sending a search to several search engines at once 

aggregating the result. 

Pros: 

 You only need to use one search tool which is time- efficient 

 You only need to learn how to use one search engine reducing learning curve 

 You benefit from the difference among several search tools at once 

 

Cons: 

 Meta search services may not be able to leverage each individual search engines full 

range of query tools resulting in less refined searches 

 You cannot personally select the search engines queried by meta search services. 

 

Viruses and/or worms. 

PURPOSE: To learn various threats on the internet and configure the computer to be safe on the 

internet. 

THEORY: 

Antivirus: 

Antivirus software is a program that either comes installed on your computer or that you purchase 

and install yourself. It protects your computer against most viruses, worms, Trojan horses and other 

unwanted invaders that can make your computer sick. 

Firewall: 
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A firewall is a special software or hardware designed to protect a private computer network from 

unauthorized access. A firewall is a set of related programs located at a network gateway server 

which protects the resources of the private network from users from other networks. 

PROCEDURE: 

Installing Symantec antivirus for Windows: 

 Insert  Symantec antivirus CD into your CD drive 

 Double click  on the Symantec-setup.exe 

 The installer will open  

 Click next to proceed 

 License agreement will open .Click I accept the terms of the license agreement and 

then click next. 

 Follow the instruction on the screen to complete the installation. 

Get Computer Updates: 

 Click start> settings>control panel 

 Click Automatic Updates icon to open Automatic Updates dialog box 

 Check the box Keep my computer up to date  

 Choose a setting 

 Click OK 

Block Pop ups: 

 In the IE open  tools>pop-up blocker 

 Click on Turn on Pop- up blocker 

Windows Firewall: 

 Go to  Start>control panel>Network and Internet Connections>windows firewall 

 In the general tab check the On(recommended) box 

 If you don’t want any exceptions check on  Don’t allow exceptions box 

A test which simulates all of the above tasks would be crafted and given to the students. 

 

PURPOSE:  Test to simulate all the tasks related to Internet Security 
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THEORY: 

 Identify and explain the components  required to establish a network 

 Establish internet connection and create a new email id , send mail and attachment file to 

other mail account 

 Define search engine. List the various search engines. Navigate through any of the search 

engine like Google and explore its features. 

 Download a file from the internet. Write the various steps involved in downloading 

 What is Antivirus software? List a few popular anti-virus kits available. 

 Explain the functionality of the firewall quoting a few examples 
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TASK 5 

 
Word Orientation: an overview of Microsoft (MS) office 2007/ 10: Importance of  MS office 

2007/10, overview of toolbars, saving files, Using help and resources, rulers, format painter. 

 

INTRODUCTION TO MS-OFFICE 

Microsoft office is a set of inter related desk top applications ,servers and services, collectively refers to  

as an office suit for the micro soft windows and MAC OSX operating systems . 

 

           MS WORD: 

Microsoft Word is a word processing software package. we can use it to type letters, reports, and 

other documents. In Word 2007, how a window displays depends on the size of your window,  the 

size of Your monitor and the resolution to which your monitor is set. Resolution determines how 

much information your computer monitor can display.
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STARTING MS WORD:-  

Two ways of starting MSWORD:- 

Double click on Microsoft word icon on the desk top. 

Click on start ->programs->ms office ->ms word. 

 

The Microsoft Office Button 

In the upper-left corner of the Word 2007 window is the Microsoft Office button. When you click 

the button, a menu appears. You can use the menu to create a new file, open an existing file, save a 

file, and perform many other tasks. 

 

The Quick Access Toolbar 

          The Quick Access toolbar provides you with access to commands you frequently use. By default 

Save, Undo, and Redo appear on the Quick Access toolbar. You can use Save syour file, Undo to 

rollback an action you have taken, and Redo to reapply an action you have rolled back. 
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The Ribbon 

We use the Ribbon to issue commands. The Ribbon is located near the top of the screen, below the 

Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays several 

related command groups. Within each group are related command buttons. You click buttons to 

issue commands or to access menus and dialog boxes 

 

 

         The Ruler 

We can use the ruler to change the format of your document quickly 

 

The Text Area 

You type your document in the text area. The blinking vertical line in the upper-left corner of the 

text area is the cursor. 
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The Status Bar 

The Status bar appears at the very bottom of your window and provides such information as the 

current page and the number of words in your document. 

 

Using Latex and Word to create project certificate. Features to be covered:-Formatting Fonts in 

word, Drop Cap in word, Applying Text effects, Using Character Spacing, Borders and Colors, 

Inserting Header and Footer, Using Date and Time option in both LaTeX and Word. 
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b)Using Word to create project certificate. Features to be covered:-Formatting Fonts in word, Drop 

Cap in word, Applying Text effects, Using Character Spacing, Borders and Colors, Inserting Header 

and Footer, Using Date and Time option in Word. 

The graphical user interface (GUI) provides ways to apply the various font formatting options (or 

character formatting options) to your text. In Word 2010 and Word 2007, many of these options 

are displayed directly in the Font group on the Home tab of the Ribbon and on the contextual 

toolbar that appears when you right-click within text. Additional options are available in 

the Font dialog box, which you can open by clicking the Font dialog box launcher ( ) in the lower 

right-hand corner of the Font group on the Hometab. In Word 2003, many of these options are 

displayed directly on the Formatting toolbar, and additional options are available in the Font dialog 

box, which you can open by right-clicking and then clicking Font ( ) on the context-sensitive menu 

that opens or by clicking Font on the Format menu. The Font dialog box has two tabs. 

Font 

Character Spacing 

The font formatting options that you can configure on the Font tab in the Font dialog box influence 

the appearance of the individual characters in your text. 
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A drop cap is a specially formatted letter that appears at the beginning of a paragraph. Word 2007 

offers two styles of drop caps. The first, and more common, begins the paragraph with a large letter 

that spills down into the text. Thus, the drop cap displaces the first few lines of the paragraph. The 

second style places the large first letter in the margin adjacent to the paragraph. 

Add an effect to text 

Select the text that you want to add an effect to. 

On the Home tab, in the Font group, click Text Effect. 

 

Click the effect that you want. 

For more choices, point to Outline, Shadow, Reflection, or Glow, and then click the effect that you 

want to add. 

Remove an effect from text 

Select the text that you want to remove an effect from. 

On the Home tab, in the Font group, click Clear Formatting. 

 

 

If you want to add a graphic or text at the top or the bottom of your document, you need to add a 

header or footer. You can quickly add a header or a footer from the galleries, or you can add a 

custom header or footer. 

You can use these same steps to add a header or footer without page numbers. 

Add a header or footer from the gallery 

On the Insert tab, in the Header & Footer group, click Header or Footer.  

http://www.dummies.com/how-to/content/how-to-add-a-drop-cap-in-word-2007.html#glossary-drop_cap
http://www.dummies.com/how-to/content/how-to-add-a-drop-cap-in-word-2007.html#glossary-drop_cap
http://www.dummies.com/how-to/content/how-to-add-a-drop-cap-in-word-2007.html#glossary-style
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Click the header or footer that you want to add to your document.  

To return to the body of your document, click Close Header and Footer on the Design tab (under 

Header & Footer Tools).  

 

Click where you want to insert the date or time. 

On the Insert tab, in the Text group, click Quick Parts. 

 

Click Field. 

In the Categories box, click Date and Time. 

In the Field names box, click Create Date, Print Date, or Save Date. 

In the Date formats box, click the date and time format that you want — for example, 2/12/2008 

9:45 PM or 12 February 2008. 
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TASK 6 

Creating project abstract Features to be covered:-Formatting Styles, Inserting table, Bullets and 

Numbering, Changing Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell Check, 

Track Changes. 

To create a document applying the above mentioned techniques. 

THEORY:   

 Table:  A table consists of rows and columns. 

 Cell Alignment: 

Aligns contents written in a table in the top left corner or top right corner or in the center etc. 

 Foot Note: 

Foot notes are used to comments on, or provide references for text in a document. 

 Hyperlink: 

It is a colored and underlined text or a graphic that you click to go to a file, a  location in a file , an 

HTML page on the world wide web, or an HTML page in an intranet. 

Symbols: 

You may not be able to enter certain symbols into your word document, as there is a limitation on 

the keys on the key board. Creating these new symbols especially when working with mathematical 

terms it becomes very difficult .For example we can insert symbols such as,,, 

Spell check: 

It automatically checks for spelling and grammatical errors 

Bullets and Numbering: 

In Microsoft word we can easily create bulleted or numbered list of items. 

Formatting Styles: 
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A style is a set of rules to be followed for the effective document. Style can be applied to text, 

paragraph, table or a list. 

Changing text direction:   

You can change the text orientation in drawing objects, such as text boxes, shapes, and callouts, or 

in table cells so that the text is displayed vertically or horizontally. 

Track changes: 

Track changes is a an excellent feature of Microsoft word as it enables a user or reviewer to keep 

track of the changes that have taken a period. Changes like insertion, deletion or formatting changes 

can be kept track of. 

Procedure: 

Changing Text direction: 

1. Click the drawing object or table cell  that contains the text you want to change.  

2. On the Format menu, click Text Direction.  

3. Click the orientation you want. 

Table: 

1. Click where you want to create a table. 

2. On the Table menu, point to Insert, and then click Table. 

3. Under Table size, select the number of columns and rows. 

4. Under AutoFit behavior, choose options to adjust table size. 

5. To use a built-in table format, click AutoFormat. 

Select the options you want 

Cell Alignment: 

1. Click the cell that contains text you want to align.  

2. On the Tables and Borders toolbar, select the option for the horizontal and vertical alignment 

you want— for example, Align Bottom Center or Align Top Right.  
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Foot Note: 

1. In print layout view, click where you want to insert the note reference mark.  

2. On the Insert menu, point to Reference, and then click Footnote.  

3. Click Footnotes or Endnotes.  

By default, Word places footnotes at the end of each page and endnotes at the end of the 

document. You can change the placement of footnotes and endnotes by making a selection 

in the Footnotes or Endnotes box. 

4. In the Number format box, click the format you want.  

5. Click Insert.  

Word inserts the note number and places the insertion point next to the note number. 

6. Type the note text.  

7. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word automatically applies 

the correct number format. 

Hyper link: 

Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink on the 

Standard toolbar 

Do one of the following:  

1. Link to an existing file or web page: 

1. Under Link to, click Existing File or Web Page. 

2. In the Address box, type the address you want to link to or, in the Look in box, click 

the down arrow, and navigate to and select the file 

2. Link to a file you haven’t created yet 

Under Link to, click Create New Document. 
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3. In the Name of new document box, type the name of the new file.  

4. Under When to edit, click either Edit the new document later or Edit the new 

document now 

An e-mail address: 

1. Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink 

on the Standard toolbar 

2. Under Link to, click E-mail Address. 

3. Either type the e-mail address you want in the E-mail address box, or select an e-mail address 

in the recently used e-mail addresses box.  

4. In the Subject box, type the subject of the e-mail message 

A specific location in another document  

1. Insert a bookmark in the destination file or Web page.  

2. Open the file that you want to link from, and select the text or object you want to display as 

the hyperlink.  

3. On the Standard toolbar, click Insert Hyperlink .  

4. Under Link to, click Existing File or Web Page.  

5. In the Look in box, click the down arrow, and navigate to and select the file that you want to 

link to.  

6. Click Bookmark, select the bookmark you want, and then click OK. 

Symbol: 

1. Click where you want to insert the symbol.  

2. On the Insert menu, click Symbol, and then click the Symbols tab.  

3. In the Font box, click the font that you want.  

4. Double-click the symbol that you want to insert.  

5. Click Close 

Spell check: On the Standard toolbar, click Spelling and Grammar .  
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1. When Word finds a possible spelling or grammatical problem, make your changes in the 

Spelling and Grammar dialog box.  

Bullets and Numbering: 

1. Type 1.to start a numbered list or * (asterisk) to start a bulleted list, and then press 

SPACEBAR or TAB. 

2. Type any text you want. 

3. Press ENTER to add the next list item. 

Word automatically inserts the next number or bullet. 

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number 

in the list 

Formatting Styles: 

1. Select the words, paragraph, list, or table you want to change.  

2. If the Styles and Formatting task pane  is not open, click Styles and Formatting on the 

Formatting toolbar 

3. Click the style you want in the Styles and Formatting task pane. 

If the style you want is not listed, click All Styles in the Show box 

Track Changes: 

1. Open the document you want to revise.  

2. On the Tools menu, click Track Changes 
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b)Creating a Newsletter: Features to be covered:- Table of Content, Newspaper columns, Images 

from files and clipart, Drawing toolbar and Word Art, Formatting Images, Textboxes, Paragraphs 

and Mail Merge in word. 

Description about MS-wrod: 

 To create a news Letter Microsoft Word is a popular and commonly used word processing 

program. It is one of the most popular word processing programs, if not the most popular. Microsoft 

Word is often used in businesses, schools and universities. 

THEORY: 

Microsoft Word is a popular and commonly used word processing program. It is one of the most 

popular word processing programs, if not the most popular. Microsoft Word is often used in 

businesses, schools and universities. 

Table of contents: 

  Table of contents displays a list of headings in a created document. It basically 

provides an outline of the entire document created 

Newspaper columns: 

  One can create a newspaper columns document by specifying the number of new 

letter-style column required and then adjust their width , and add vertical lines between columns. 

Images from files and clipart: 

  Inserting a picture (graphic) from a file and clipart may be required for a document. 

This picture could be a scanned photograph or any other digitally produced one. This pictures can be 

modified , resized, cropped and enhanced. 

Drawing toolbar and Word Art: 

  One can create his/her own drawings in Microsoft word.Ms word provides a full 

fledged drawing tool bar.Word Art in Microsoft word enables you to create special and decorative 

text. 
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Formatting Images, Textboxes and Paragraphs: 

Formatting an image includes selecting appropriate color, size, layout and cropping.Generally the 

text in a document follows a standard orientation (line after line). A text box provides a different 

orientation to the text with in a document. It can arrange the text in any where and can be resized 

and moreover moved to any section of the document or even outside. 

  When you are formatting a paragraph, you do not need to highlight the entire 

paragraph. Placing the cursor anywhere in the paragraph enables you to format it. After you set a 

paragraph format, subsequent paragraphs will have the same format unless you change the format 

PROCEDURE: 

Table of contents: 

1. Click where you want to insert the table of contents.  

2. On the Insert menu, point to Reference, and click Index and Tables.  

3. Click the Table of Contents tab.  

4. To use one of the available designs, click a design in the Formats box.  

5. Select any other table of contents options you want.  

Newspaper columns: 

1. Select the entire or part of document to be converted into a newsletter-style 

2. Click on format menu , select columns 

3. Any desired number of columns are presets-one or two or three or left or right b\can be selected. 

4. Width and spacing can be fixed and equal columns width can be checked for uniformity 

5. If a newspaper columns are to be separated by a line, then check line between 

6. Under apply to will be whole document if entire document is selected else we have to select a 

selected text. 

7. Click ok 

Inserting images from files and clip art: 
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1. Click where you want to insert the picture.  

2. On the Insert menu, point to Picture, and then click From File.  

3. Locate the picture you want to insert.  

4. Double-click the picture you want to insert.  

CLIP ART: 

1. On the Insert menu, point to Picture, and then click Clip Art.  

2. In the Clip Art task pane, in the Search for box, type a word or phrase that describes 

the clip you want or type in all or some of the file name of the clip.  

3. To narrow your search, do one or both of the following:  

 To limit search results to a specific collection of clips, in the Search in box, click 

the arrow and select the collections you want to search.  

 To limit search results to a specific type of media file, in the Results should be 

box, click the arrow and select the check box next to the types of clips you 

want to find.  

4. Click Go.  

5. If you don't know the exact file name, you can substitute wildcard characters for one 

or more real characters. Use the asterisk (*) as a substitute for zero or more characters in a 

file name. Use the question mark (?) as a substitute for a single character in a file name. 

6. In the Results box, click the clip to insert it.  

Drawing Toolbar and Word Art: 

1. Click in your document where you want to create the drawing.  

2. On the Insert menu, point to Picture, and then click New Drawing.  

A drawing canvas is inserted into your document. 

3. Use the Drawing toolbar to add any shapes or pictures that you want.  

WORD ART: 

1.On the Drawing toolbar, click Insert WordArt .  
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2.Click the WordArt effect you want, and then click OK.  

3.In the Edit WordArt Text dialog box, type the text you want. 

4. Do any of the following:  

 To change the font type, in the Font list, select a font.  

 To change the font size, in the Size list, select a size.  

 To make text bold, click the Bold button.  

 To make text italic, click the Italic button.  

Formatting Images: 

1. Formnatting of the images can be achieved by selecting the image and double click on the 

picture, format picture dialog box appears. 

2. The same can be achieved by selecting the tools menu > customize>tool bars tab>picture 

and click close. 

Basic formatting features of an image 

Resize a drawing 

1. Select the drawing canvas 

2. On the Drawing Canvas toolbar, do one of the following: 

o To make the drawing canvas boundary larger without changing the size of the objects 

on the canvas, click Expand . 

o To make the drawing canvas boundary fit tightly around the drawing objects or 

pictures, click Fit . 

o To scale the drawing and make the objects and canvas proportionately smaller or 

larger, click Scale Drawing, and then drag the edges of the canvas. 

Resize a picture or shape 
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1. Position the mouse pointer over one of the sizing handles  

2. Drag the sizing handle until the object is the shape and size you want.  

To increase or decrease the size in one or more directions, drag the mouse away from or 

toward the center, while doing one of the following:  

o To keep the center of an object in the same place, hold down CTRL while dragging the 

mouse.  

o To maintain the object's proportions, drag one of the corner sizing handles.  

o To maintain the proportions while keeping the center in the same place, hold down 

CTRL while dragging one of the corner sizing handles. 

Crop a picture 

1. Select the picture you want to crop.  

2. On the Picture toolbar, click Crop .  

3. Position the cropping tool over a cropping handle and then do one of the following:  

o To crop one side, drag the center handle on that side inward.  

o To crop equally on two sides at once, hold down CTRL as you drag the center handle 

on either side inward.  

o To crop equally on all four sides at once, hold down CTRL as you drag a corner handle 

inward.  

4. On the Picture toolbar, click Crop to turn off the Crop command. 

Text Box: 

1. On the Drawing toolbar, click Text Box .  

2. Click or drag in your document where you want to insert the text box 

3. You can use the options on the Drawing toolbar to enhance a text box— for example, to 

change the fill color— just as you can with any other drawing object 

Paragraphs: 

Change line spacing  
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Select the text you want to change. 

1. On the Formatting toolbar, point to Line Spacing, and then do one of the following:  

o To apply a new setting, click the arrow, and then select the number that you want.  

o To apply the most recently used setting, click the button.  

o To set more precise measurements, click the arrow, click More, and then select the 

options you want under Line Spacing.  

Change spacing before or after paragraphs 

1. Select the paragraphs in which you want to change spacing.  

2. On the Format menu, click Paragraph, and then click the Indents and Spacing tab.  

3. Under Spacing, enter the spacing you want in the Before or After box.  

Change paragraph direction 

1. Place the insertion point in the paragraph that you want to change, or select several 

paragraphs.  

2. Do one of the following:  

o To have text begin from the left, click Left-to-Right on the Formatting toolbar.  

o To have text begin from the right, click Right-to-Left on the Formatting toolbar.  

When you change the paragraph direction, Microsoft Word leaves justified and centered text as it is. 

In the case of left-aligned or right-aligned text, Word flips the alignment to its opposite. For 

example, if you have a left-to-right paragraph that is right aligned, such as the date at the top of a 

letter, clicking Right-to-Left results in a right-to-left paragraph that is left aligned. 
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TASK 7 

Excel Orientation: The importance of MS office 2007/10 tool Excel as a Spreadsheet tool, 

Accessing, overview of toolbars, saving excel files, Using help and resources. 

Creating a Scheduler - Features to be covered:- Gridlines, Format Cells, Summation, auto fill, 

Formatting Text 

 

Excel Introduction 

Excel Orientation: The mentor needs to tell the importance of MS office 2007/ equivalent (FOSS) 

tool Excel as a Spreadsheet tool, give the details of the two tasks and features that would be covered 

in each. Using Excel – Accessing, overview of toolbars, saving excel files, Using help and resources. 

PROCEDURE: 

 First click start button of the screen on status bar. Click on programs and then Microsoft 

excel. To get a new blank work sheet go to programs and then click on excel sheet. On the file menu 

click page setup and then click sheet tab click gridlines. In this way do the required changes using 

format cell, make the required changes using formatting text also make the required changes. Enter 

the data in the data in the worksheet consisting of week name person name and timings 7 a.m. to 3 

p.m. Make all the above changes to the text. 

Introduction to MS-Excel 

    Excel is a computerized spreadsheet, which is an important business tool that helps you report 

and analyze            information.   Excel stores spreadsheets in documents called workbooks. Each 

workbook is made up of individual worksheets, or sheets. Because all sorts of calculations can be 

made in the Excel spreadsheet, it is much more flexible than a paper  spreadsheet. The Excel window 

has some basic components, such as an Active cell, Column headings, a Formula bar, a Name box, 

the mouse pointer, Row headings, Sheet tabs, a Task Pane, Tab scrolling buttons and Toolbars.  

         Sample Worksheet 
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Excel worksheet and workbooks 

When you set up calculations in a worksheet, if an entry is changed in a cell, the spreadsheet will 

automatically              update any calculated values that were based on that entry.   When you open 

Excel, by default it will open a blank workbook with three blank worksheets.    When you save a 

workbook, you have a Save As option that can save the spreadsheet to earlier versions of  Excel or to 

Quattro Pro, Lotus 123 formats, dBase formats, and even to a comma or tab-delimited text file. 

         Identify Excel components 

 

        Navigate within worksheet 

To navigate within a workbook, you use the arrow keys, Page Up, Page Down, or the Ctrl key in 

combination   with the arrow keys to make larger movements.      The most direct means of 

navigation is with your mouse.  
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Scroll bars are provided and work as they do in all Windows applications.To move to other 

Worksheets, you can:  

A. Click their tab with the mouse 

B. Use the Ctrl key with the Page Up and Page Down keys to move sequentially up or down through the 

worksheets. 

If you are familiar with Microsoft Access, you will find the tab scrolling buttons for moving between 

worksheets to be similar to record browsing on an Access form or datasheet.  

 

Developing a Worksheet  

Determine the worksheet’s purpose. 

Enter the data and formulas. 

Test the worksheet and make any necessary edits / corrections. 

 Document the worksheet and improve appearance. 

Save and print the complete worksheet. 

Entering data into a worksheet 

To enter data, first make the cell in which you want to enter the data active by clicking it. 

 Enter the data (text, formulas, dates, etc.) into the active cell. 

Use the Alt+Enter key combination to enter text on multiple lines within the same cell. 

Use TAB key, arrow keys, or ENTER key to navigate among the cells. 

Entering Formulas 

A formula is a mathematical expression that calculates a value. 

In Excel, formulas always begin with an equal sign (=). 

A formula can consist of one or more arithmetic operators. 

 The order of precedence is a set of predefined rules that Excel follows to calculate a formula. 
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Resize worksheet rows and columns 

There are a number of methods for altering row height and column width using the mouse or 

menus:  

Click the dividing line on the column or row, and drag the dividing line to change the width of the 

column or Height of the row Double-click the border of a column heading, and the column will 

increase in width to match the length of the longest entry in the column  Widths are expressed 

either in terms of the number of characters or the number of screen pixels.  

         Identify cell ranges 

     A group of worksheet cells is known as a cell range, or range. 

 Working with ranges in a worksheet makes working with the data easier. 

 Ranges can be adjacent or nonadjacent. 

 An adjacent range is a single, rectangular block of cells 

 Select an adjacent range by clicking on a cell and dragging to an opposite corner of a 

rectangle of cells 

 A nonadjacent range is comprised of two or more adjacent ranges that are not contiguous to 

each other 

 .To select a nonadjacent range, begin by selecting an adjacent range, then press and hold 

down the Ctrl key as you select other adjacent ranges 

Select and move worksheet cells 

  To select a large area of cells, select the first cell in the range, press and hold the Shift key, and then 

clickthe     last cell in the range.  

Once you have selected a range of cells, you may move the cells within the worksheet by clicking 

and dragging the selection from its current location to its new one.  

   By pressing and holding the Ctrl key as you drag, Excel will leave the original selection in its place and 

paste a    copy of the selection in the new location. To move between workbooks, use the Alt key 

while dragging the selection. 
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          Insert worksheet rows and columns  

   You can insert one or many additional rows or columns within a worksheet with just a few steps using 

the mouse   or menu options.   You can insert individual cells within a row or column and then choose 

how to displace the existing cells.    You can click the Insert menu and then select row or column, or 

right click on a row or column heading or a selection of cells and then choose Insert from the shortcut 

menu.  

         Delete worksheet rows and columns 

   To delete and clear cells, rows, or columns, you can use the Edit menu, or right click on a heading or 

a selection  of cells and choose Delete from the shortcut menu.   Clearing, as opposed to deleting, 

does not alter the structure of the worksheet or shift unclear data cells.   What can be confusing about 

this process is that you can use the Delete key to clear cells, but it does not remove    them from the 

worksheet as you might expect. 

Use undo and redo features 

        Editing is an intrinsic task in any document, and especially useful are the Undo and Redo actions. 

The Undo feature allows you to sequentially back up to a certain action, such as a delete, a move, an 

entry, etc.   And allows you to reverse those actions. 

   Redo allows you to reapply actions one step at a time that you have previously undone. 

          Print as workbook 

To print a worksheet, you can use: 

      A menu 

     The Print button on the standard toolbar    

The Ctrl-P keystroke to initiate a printout of the worksheet 
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b)Calculating GPA - .Features to be covered:- Cell Referencing, Formulae in excel – average, std. 

deviation, Charts, Renaming and Inserting worksheets, Hyper linking, Count function, 

LOOKUP/VLOOKUP, Sorting, Conditional formatting . 

PURPOSE: 

To maintain a control chart for printing books with given data. 

THEORY: 

1. On the chart menu click chart type 

2. Text direction. 

Click the arrow down next to the text direction button. For right to left click right to left. For 

left to right reading order, click left to right.  

For reading order that is consistent with the language of the first entered character, click 

context. For reading order that is inconsistent with the language of the first entered character, 

click control. 

     3. In the tools menu click options and then click chart tab. 

     4. To show all worksheet data in the chart even if some rows and columns are hidden, clear the 

plot visible cells by check box. 

5. To prevent hidden rows and columns from displaying in the chart, select the plot cells only 

check box. 

Hyper Linking: 

1. Create a worksheet: On the file menu, click new, and then click blank workbook task pane. 

2. Insert a worksheet: C lick worksheet on the insert menu. Right click on sheet tab and then 

click insert double click the template for the type of sheet you want. 

3. Hyperlink:  Using hyperlink we can insert one more sheet in the present sheet 
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4. Count function:  Create a blank worksheet press control +c. In the worksheet select cell A 

and press control +c. On the tools menu point to formula auditing and then click formula 

auditing menu. 

Worksheet: 

1.In the file menu go to menu then a new worksheet is created. 

2. To add a single worksheet, click worksheet on the Insert menu. To add multiple worksheets hold 

down shift and then click the number of worksheet tasks to add in a open workbook 

Sort:  

1. Click a cell in the list you want to sort. 

2. On the Data menu click sort. 

3.  Under first key sort click the custom sort order you want and then click ok. 

4. Click any other sorting option you want. 

 

PROCEDURE: 

Formulae in Excel: 

First click on start button at the bottom of the screen on status bar. Click on programs and 

then on Microsoft excel. Then open a new document. Give the main heading and subheading by 

changing the size so that they look in block letters. Enter the data. To calculate go to Insert menu in 

the menu bar and then click on function and then ok. Then select the data to which you want to 

calculate mean. Then you get the required answer. In same way, sample means standard deviation 

lower count limit and upper count limit. Go to insert menu and click on function and select the 

required operation to be done and select the data and calculate. Formulas for all the above are 

given below. 

Mean = (s1 + s2 + s3 + s4 + s5)/5; 

Sample mean = avg (mean) 

Standard deviation = (mean, sample, mean) 

Sample standard deviation= avg (Standard deviation) 
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Lower count limit = sample mean – sample standard deviation. 

Upper count limit = Sample mean + Sample Standard deviation 

Hyper linking: 

        First click on start button of the screen on status bar. Click on programs and then Ms-

excel. To get a new blank worksheet go to programs and then click on excel sheet. Rename the first 

sheet as student by right clicking on sheet 1 and renaming. Insert hyperlink insert and click on 

hyperlink. Then go to sheet 2 and rename as CSE type in particulars of ECE right click on sheet 3. 

Then go to sheet -4 rename as IT. In this type all the four sheets are created. 

WORKSHEET 

                    First click on start button at the bottom of the screen on status bar. Click on programs 

and then Ms-excel. Then enter the data as given. Enter the student’s names, Subjective wise marks, 

total and avg. Then calculate the total and avg by using formula. Then go to Data menu and click 

sort. Under first key sort, click custom sort order needed i.e. ascending order or alphabetical order 

and then click o.k. Then the required worksheet is prepared, 
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TASK 8 

Basic power point utilities and tools which help ful to create basic power point presentation. Topic 

covered during this includes PPT Orientation, Slide Layouts, Inserting Text, Word Art, Formatting 

Text, Bullets and Numbering, Auto Shapes, Lines and Arrows in both Latex and Power point. 

 

Introduction 

PowerPoint is a application used for the creation of presentations. These presentations are laid out in 

a      "storyboard" type fashion, where individual slides are created and formatted with text and 

images. PowerPoint presentations are widely used in classrooms as note outlines for teachers, and 

for project presentations by       students. The point of the slides in PowerPoint presentations is NOT 

to fit as much detailed information as you    can onto a single slide. Rather, each slide should 

contain elements that briefly sum up the major idea(s) of what you will be presenting for the 

duration of the slide. The style in which you create slides is completely up to you.    PowerPoint 

allows you to choose from a wide variety of formats that include sections such as titles, lists, 

images, or charts. Any of these can be incorporated into your presentation. The main thing to keep 

in mind, however, is that an audience will be viewing this material; it must be large enough to read, 

yet not so large that it takes up far too much of the screen to include relevant information. All 

Writing Program computer classrooms come equipped with PowerPoint already installed on the 

computers. 

TITLE:  

 Create a power point presentation consists of slide layouts inserting text, formatting text, 

bullets and numbering of five slides with following information’s. 

Slide 1 – contents 

Slide 2 – Name 

Slide 3 – Address 

Slide 4 – Hobbies 

Slide 5 – Friends 
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PURPOSE: 

 To maintain a PowerPoint presentation with some specifications 

THEORY:Microsoft PowerPoint is the name of a proprietary commercial software presentation 

program developed by Microsoft. It was developed by Microsoft and officially launched on May 22, 

1990 

SLIDE LAYOUT:  

1. On the format menu, click slide layout. 

2. On the slides tab in normal view, select the slides; you want to apply a layout too. 

3. In the slide layout task pane, point to layout you and then click it. 

4. A new slide can also be inserted within the task pane. Point the layout you want the slide 

to have, click the arrow and then click the insert new slide. 

INSERT TEXT:  

1. Text can be added to layout. 

2. Align text in the top, middle or bottom of a cell. 

3. Align text on the right or left, or in the center of a cell. 

4. Change cell margins. 

5. Insert a tab in a table. 

6. To make the symbol command available, in normal view, place the insertion point on the 

outbox tab or in a text place holders on the slide. 

7. On the insert menu, click symbol. 

8. To change fonts, click a name in the font box. 

FORMATTING TEXT: 

1. Select the text you want to format as superscript or subscript. 

2. On the format menu, click font. 

3. To show or hide text formatting, on the standard toolbar, click show formatting. 

BULLETS AND NUMBERINGS: 

1. Select the lines of text that you want to add bullets or numbering to. 

2. Click bullets or numbering. 
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AUTOSHAPES: 

1. Select the auto shape that has the text you want to position. 

2. Double-click the selection rectangle of the auto shape or text box and then click the text 

box tab in the format dialog box. 

3. in the text anchor point box, click the position you want the text to start in. 

        LINES AND ARROWS:  

1. In Microsoft power point, double click the chart. 

2. Double click the chart item you want to change. 

3. On the patterns tab, do one or both of the following. 

4. To change the colors, patterns or lines, select the options you want. 

5. To specify a fill effect, click fill effect and then select the options you want on the 

gradient, text patterns or picture tabs. 

To return to the slide, click outside the about. 

PROCEDURE: 

 First click on start button at the button of the screen on status bar. Click on programs and 

then Microsoft PowerPoint. Go to file and new. Then you find different pattern of slides on right side 

of your screen. Then select which is completely empty. Then enter the contents in the first slide as 

per given information, name in the second slide, Address in the third slide, Hobbies in the fourth 

slide and friends in the fifth slide. Except first slide, all the second, third, fourth, fifth slides should be 

inserted. When you select pattern of slide from a new slide, on slide which you selected you will find 

an arrow towards its right side, click that arrow and then again click insert slide. Then save it. Then 

adjust the layout. Then format the text then give bullets or numbering to the text if required. Go to 

auto shapes. Select more auto shapes and insert wherever required. Then again go to insert option 

and select new slides. And select chart and a chart with datasheet appear. Give the name, roll no, 

marks in three subjects and calculate the total. Then save the file 

 Create a power point presentation consisting of hyperlinks, inserting images, clip art, audio, 

video objects of 4 slides with the following information. 

 Slide 1:- Name of your college in bold letters. 

 Slide 2:- Address of your college in bold letters. 
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 Slide 3:- List of all available courses. 

 Slide 4:- Extra co-curricular activities. 

 And apply the transaction effects and set the time three seconds for each slide and view it in 

slide show. 

PURPOSE: 

 To maintain a PowerPoint presentation using some specifications 

THEORY:  

HYPERLINK:  

1. Select the text or object that you want to represent the hyperlink. 

2. Click insert hyperlink. 

3. Under link to, click place in this document. 

INSERT IMAGES: 

1. Click where you want to insert the picture. 

2. On the drawing tool bar, click insert picture. 

3. Locate the folder that contains the picture that you want to insert, and then click the 

picture file. 

CLIP ART:   

1. On the insert menu, point to structure and then click clipart. 

2. in the clipart task pane, in the search for box, type a word or phrase that describes the 

clip, you want to type in all or some of the file menus of the clip. 

3. in the results box, click the clip to insert it. 

AUDIO VIDEO OBJECTS: 

1. On the slide show menu, click setup show. Under performance check box. If your 

computer has their capability, office PowerPoint will attempt to use it. 

2. Animation performance will be much better with a video card that has Microsoft direct 

3D. 

TABLE: 

1. On the standard tool bar, click insert table. 
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2. Print to select the numbers of rows and columns you want and then click. 

      CHART: 

1. Click the slide where you want to place the embedded object. 

2. On the insert menu, click chart. 

3. Click a cell on the data sheet and then type the information you want. 

To return to the slide, click outside the chart 

PROCEDURE: 

 First click on start button at the bottom of the screen on status bar. Click on programs and 

then Microsoft power point goto file menu. Then you find different pattern of slides on right side of 

your screen. Then select which is completely empty. Then enter the name of your college in bold 

letters. Address of your college in bold letters in the second slide. List of all the available courses in 

the third slide, extra co-curricular activities in the fourth slide except first slide, all the second, third, 

fourth slide should be inserted. When you select pattern of slide from a new slide, on slide which 

you selected, you will find an arrow towards it right side click that arrow and then again click insert 

slide. Then save it the select the slide show and then select the view show option. Then review the 

presentation in slide show by selecting next and after completing the slide show then click end 

show. Click on start button at the button of the screen on status bar, click on programs and then 

Microsoft power point. Go to file menu. On insert menu and select table option and give no. of rows 

and no. of columns and give the name, Roll no and marks in three subjects and find the total 

TITLE: 

 Create a power Point presentation on business by using master layouts and see the 

presentation in different views. 

PURPOSE: 

 To maintain a power point presentation with some specifications 

THEORY:- 

       MASTER LAYOUTS:-   

1. On the view menu, point to master, and then click slide master. 
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2. To insert a slide master, do the presentation given in slides and lastly add date and 

footer to the slides. 

      SLIDE SHOW: 

1. On the slides tab in the normal view, select the slides you want to set the things for. 

2. On the slide show menu, click side transition. 

3. Under advance slide, select the automatically after checkbox, and then number of 

seconds you want the slide to appear on the screen. 

PROCEDURE: 

 First click on start button. Then click programs, and then power point presentation. Then 

select file menu and click on new. Then you get a new blank presentation. Then in the first slide, 

enter the title as business and give product name as sub title. Then insert the second slide. Then 

enter the title as about the product and give description as sub title. Then insert the third slide and 

enter the title as sales about product and enter something about it sales. In this way, complete the 

three slides. Then click on view and then master and then enter date in the space provided for 

footer. Then you find these two in all slides and then again go to view and click on slide show. 
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TASK 9 

Introduction to HTML &Basic syntax of html Attributes, elements, lists, and basic programs.                   

HYPER TEXT MARKUP LANGUAGE (HTML) 

      HTML stands for Hyper Text Markup Language. 

       HTML is the main markup language for web pages. 

      HTML elements are the basic building-blocks of Webpages. 

Markup language 

A markup language is a combination of words and symbols which give instructions on how a document 

should appear.  

HTML is written in the form of HTML elements consisting of tags enclosed in angle brackets (like 

<html>), within the web page content. 

HTML elements form the building blocks of all websites. HTML allows images and objects to be 

embedded and can be used to create interactive forms. 

      HTML Tags 

HTML tags are keywords surrounded by angle brackets like <html> 

HTML tags normally come in pairs like <b> and </b> 

The first tag in a pair is the start tag, the second tag is the end tag 

Start and end tags are also called opening tags and closing tags 

      HTML Element Syntax 

 An HTML element starts with a start tag / opening tag 

 An HTML element ends with an end tag / closing tag 

 The element content is everything between the start and the end tag 

 Some HTML elements have empty content 
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 Empty elements are closed in the start tag 

 Most HTML elements can have attributes 

      HTML Attributes 

HTML elements can have attributes 

Attributes provide additional information about an element 

Attributes are always specified in the start tag 

Attributes come in name/value pairs like: name="value" 
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TASK 10 

Home page using HTML Consisting of photo, name, address and education details as a table 

HTML Tables 

Tables are defined with the <table> tag. 

A table is divided into rows (with the <tr> tag), and each row is divided into data cells (with the <td> 

tag). tdstands for "table data," and holds the content of a data cell. A <td> tag can contain text, links, 

images, lists, forms, other tables, etc. 

HTML Styles 

Example 

<table border="1"> 

<tr> 

<td>row 1, cell 1</td> 

<td>row 1, cell 2</td> 

</tr> 

<tr> 

<td>row 2, cell 1</td> 

<td>row 2, cell 2</td> 

</tr> 

</table> 

     HTML Text Formatting Tags 

<B> Defines bold text 

<BIG> Defines big text 

<EM> Defines emphasized text 

<I> Defines italic text 

<SMALL> Defines small text 

<STRONG> Defines strong text 
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<SUP> Defines subscripted text 

<SUP> Defines superscripted text 

<INS> Defines inserted text 

<  DEL> Defines deleted text 

    HTML Lists 

 The most common HTML lists are ordered and unordered lists: 

An ordered list: 

The first list item 

 The second list item 

 The third list item 

 An unordered list: 

List item 

   List item 

List item 

    HTML Images 

In HTML, images are defined with the <img> tag.  

<imgsrc="boat.gif“> 

HTML Frames 

With frames, you can display more than one HTML document in the same browser window. Each 

HTML document is called a frame, and each frame is independent of the others. 

Example 

   <frameset cols="25%,75%"> 

   <frame src="frame_a.htm" /> 
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   <frame src="frame_b.htm" /> 

  </frameset> 

HTML Fonts 

<p> 

<font size="5" face="arial" color="red"> 

This paragraph is in Arial, size 5, and in red text color. 

</font> 

</p> 

<p> 

<font size="3" face="verdana" color="blue"> 

This paragraph is in Verdana, size 3, and in blue text color. 

</font> 

</p> 
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BOOKS & REFERENCE BOOKS: 

TEXT BOOKS: 

1. Comdex Information Technology Course tool kit   ‘Vikas Gupta, WILEY Dreamtech 

2. Introduction to Computers- Peter Norton’s. 

REFERENCE BOOKS: 

1. Complete computer upgrade and Rep-air book, 3rd edition Cheryl A Schmidt, Wiley 

Dreamtech 

2. Introduction to Information Technology, ITL Education Solutions limited, Pearson Education. 

3. PC Hardware and A +Handbook –Kate J. Chase PHI(Microsoft) 

4. Latex Companion –Leslie Lamport, PHI/Pearson 

5. “Introduction to Computers with MS-Office 2000”, Alexis Leon and Mathews Leon, Leon Tech 

world. 


